Getting Started with KompoZer
Contents
Web Publishing with KompoZer .............................................................................................................................................. 1
Objectives ................................................................................................................................................................................... 1
UNIX computer account ........................................................................................................................................................... 1
Resources for learning more about WWW and HTML ......................................................................................................... 1
Introduction ............................................................................................................................................................................... 2
Publishing files on the World Wide Web ................................................................................................................................. 2
UNIX file structure .................................................................................................................................................................... 3
Exercise 1: Prepare your directory .......................................................................................................................................... 3
Using KompoZer to create a Web page ................................................................................................................................... 4
Exercise 2: Begin your Web page ........................................................................................................................................... 4
Exercise 3: Add text to your Web page................................................................................................................................... 6
Browse your Web page .............................................................................................................................................................. 8
Exercise 4: Browse your file ................................................................................................................................................... 8
Name your home page ............................................................................................................................................................... 9
Create links ................................................................................................................................................................................ 9
Exercise 5: Create links......................................................................................................................................................... 10
Include images .......................................................................................................................................................................... 11
Exercise 6: Add images......................................................................................................................................................... 11
Add features to your page ....................................................................................................................................................... 13
Exercise 7: Use the features available in KompoZer ............................................................................................................ 13
View the HTML source ........................................................................................................................................................... 14
Exercise 8: View your HTML source ................................................................................................................................... 14
Publish your page .................................................................................................................................................................... 14
Use the Secure Shell File Transfer Program ......................................................................................................................... 15
How to open the SSH File Transfer window ..................................................................................................................... 15
Exercise 9: Open the SSH File Transfer window.................................................................................................................. 15
How to transfer files using the SSH File Transfer program ........................................................................................... 16
Exercise 10: Transfer files to your Web directory ................................................................................................................ 16
Exercise 11: Change Attributes in SSH FTP ........................................................................................................................ 19
How to delete files or folders using the SSH File Transfer program .............................................................................. 19
Exercise 12: Browse your published home page................................................................................................................... 20
Edit a page that is already on the Web .................................................................................................................................. 20
Appendix—View the elements of your Web page ................................................................................................................. 22

Web Publishing with KompoZer

Web Publishing with KompoZer
KompoZer provides a point and click way to create Web pages: it works like word-processing
software and allows you to add links and images as well as text. Using KompoZer, you can
revise an existing Web page to suit your needs or start from a blank page to create your own.
Since KompoZer creates a HyperText Markup Language (HTML) file that you publish on the
World Wide Web, it is not necessary to know HTML codes to publish to the Web. This method
is only one way to create a Web page.
You can download the KompoZer program for both PC and Macintosh computers from
http://www.Kompozer.net/. This document is based on the PC version of the program.

Objectives
This document will enable you to do the following:
• Identify the basic steps required to publish a Web document.
• Prepare your Copland directory to receive Web files (you only do this step once).
• Create a basic Web page using KompoZer and preview it in a browser.
• Transfer files to your Copland directory.
• Use KompoZer to edit a page that is already on the Web.
• Identify the basic elements of a Web page and their associated codes.

UNIX computer account
To transfer files to a Web directory, you must have an account on a Web server. At the
University of Delaware, the Web server is on the central UNIX server. All University of
Delaware faculty, staff, and students can access the central UNIX server using their UDelNet
IDs. Your UNIX account is a privilege granted to you by the University. You must act
responsibly when you use it, or you can lose this privilege. If you are uncertain about the proper
use of computing resources, read a copy of the Policy for Responsible Computing at the
University of Delaware on the University’s Web site:
http://www.udel.edu/ExecVP/polprod/1-14.html.

Resources for learning more about WWW and HTML
There are many good online resources with information about preparing documents for the Web,
including tutorials, style guides, editors, and other tools. You can find many of them listed at
http://www.udel.edu/ideacenter/. Information about free classes on campus as well as self-paced
training materials can be found at http://www.udel.edu/learn/.
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Introduction
The World Wide Web (WWW) is a system that enables you to make information easily available
to anyone anywhere who has a WWW browser (e.g., Firefox, Internet Explorer, Safari, etc.).
You make your information available by placing it in a file that is called a “page” or a
“document” and is specially formatted using HTML. This language consists of an easy-to-learn
set of codes that you include with the information you wish to publish. You then make the
HTML file available to a Web server.
This document shows you how to create a Web page using KompoZer—a Web page editor that
lets you design a document in a word-processing environment and creates the HTML file for
you. KompoZer has a menu bar with pull-down options and Composition and Format toolbars
with buttons for creating your document.

Publishing files on the World Wide Web
When you publish Web pages, be sure you understand the overall process. For each new page
you publish, you will perform the following steps:
1. Create the page on your computer using a Web page editor or using HTML codes. The file
you create remains on your computer’s hard drive.
2. Copy the file to the Web server (Copland) using the SSH File Transfer Program (PC) or
Fetch program (Mac) so that others can view it.
3. Once the file is uploaded to the Web server, you must set protection codes to allow others to
view your Web page.
Note: If you set up your public_html directory for this class (see instructions on the
following page), the protection codes may not need to be changed after you transfer your
files.
When you publish in official University directories, you will need to learn more about setting
protection codes. Information is available on the Web at
http://www.udel.edu/webstart/protections.html.
You can also change file protections in SSH FTP and in Fetch. See the help pages for those
programs at http://www.udel.edu/help/.
4. Once your page is in place and available, you must either give others its address or have
another page link to it.
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UNIX file structure
The UNIX file system is a hierarchy of directories and sub-directories starting from a single
directory called “root” which is represented by a / (slash). Imagine this as similar to the root
system of a plant or as an inverted tree structure. In turn, the directories and sub-directories point
to files—your documents. Your public_html directory is a sub-directory of your home directory.
This is where you will publish the Web page files that you create using this document.
In the following exercise, you will create a sub-directory of your UNIX home directory and
name it public_html.
Exercise 1: Prepare your directory
1. Double-click the SSH Secure Shell Client icon.
2. Click Quick Connect.
3. In the Connect to Remote Host dialog box, type the following:
A. In the Host Name field, type
copland.udel.edu

B. In the User Name field, type your UDelNet ID.
C. Next to Authentication Method, click the pull-down arrow and select Password.
D. Click Connect.
4. In the Enter Password dialog box, type your UNIX (e-mail) password.
If you are in a public computing site and see a question about saving your “host key” to the
local database, answer No.
5. Click OK.
6. Create your public_html directory and make it executable and readable by others: At the
UNIX (%) prompt, type
source

/www/htdocs/learn/usered/html-setup
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Note: there is a space after the word “source.”
5. At the UNIX (%) prompt, type
exit
6. From the File menu, select

Exit
to quit the SSH Secure Shell Client.

Using KompoZer to create a Web page
In the following exercises, you will create a Web page using the buttons and menu options
available in KompoZer.
Exercise 2: Begin your Web page
Note: When you create your Web page, you add or change text in the file using the mouse and
keyboard. When you start typing, the text becomes part of your Web page. If you want to delete
text, highlight it and press the DELETE or BACKSPACE keys. If you want to replace text,
highlight it and type the new text. You can also copy text from other applications and paste it
into KompoZer.
1. To open KompoZer, double-click the KompoZer desktop icon.
2. From the KompoZer View menu, select Show/Hide and make sure the following toolbars are
checked: Composition Toolbar, Format Toolbar 1, Format Toolbar 2, Edit Mode Toolbar and
Status Bar.
3. From the KompoZer Tools menu, select Options. Then, at the left of the Options window,

click New Page Settings. You will see a window like the one below:
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Under Internationalization (bottom of the page):
A. Click Choose a language. Scroll down and click English [en], then click OK.
B. For Writing direction, from the pull-down menu, select Left to right.
C. Leave Character set as is.
4. At the left of the Options window, click. You will see a window like the one below:
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Under Markup:
A. For Language, click the radio button next to XHTML 1.
B. For DTD, click the radio button next to Transitional.
C. Click OK.
Next, you will begin to add text to your page.
Exercise 3: Add text to your Web page
1. To begin your page, from the
Heading 1. Type

drop-down list on the Format toolbar, choose

Publishing Web Pages

then press the ENTER key. Notice that the drop-down list returns to Body Text.
2. From the drop-down list on the Format toolbar, choose Paragraph. Type the following
paragraph. Do not indent or press the ENTER key at the end of each line.
To publish a Web page, first create an HTML file on your computer.
Then, send a copy of the file to the Web server (copland or www). Be
sure to keep the information on your Web page current and keep your
audience in mind when designing your page.

Press the ENTER key.
3. Highlight the words your audience then click the Italics button

on the Format toolbar.

4. Click below the paragraph you just added and from the drop-down list on the Format
toolbar, choose Paragraph (if it’s not already selected). Type the following line:
The ideal Web document:

then press the ENTER key.
5. Click the Bulleted List button
and type the following items (press the ENTER key at the
end of each line). Note that each time you press the ENTER key, KompoZer inserts a bullet.
Is attractively designed.
Communicates effectively.
Leads easily to related information.
6
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Be sure to press the ENTER key at the end of the third line.
6. Click the Bulleted List button to turn off the option.
7. From the drop-down list on the Format toolbar, choose Heading 2. Type
Where do I publish my Web page?

then press the ENTER key.
8. From the drop-down list on the Format toolbar, choose Paragraph. Type the following
paragraph (do not press the ENTER key at the end of each line):
When you publish a Web page on a UD server, its location depends on
the type of document it is. Personal pages are published in your
public_html directory on copland; official University documents are
published on www.

Press the ENTER key.

9. Click the Insert Table

button.

10. In the Insert Table Properties box, click the Precisely tab then enter the following
information:
A.
B.
C.
D.

Enter 2 for the number of rows and columns.
Change the Width to 50 percent of the window.
Leave the Border set at 1 (pixel).
Click OK.

11. When the table frame has been inserted on your page, click inside the table then click the
Table button. Click the Table tab and from the Caption drop-down box, select Above
Table.
12. Click OK. Notice that the top selection handle is now well above the table. The area between
the top of the table and the handle is where you will type the caption.
13. Type the following information in the table. Type the caption first. Then click in the upperleft table cell and type the text. Use the TAB key to move among table cells. As you type, the
cell size adjusts automatically to accommodate text.
© University of Delaware Information Technologies
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copland
www

What is the URL of My Web Page?
http://udel.edu/~your_UDelNet_ID/filename.html
http://www.udel.edu/directory_path/filename.html

You can modify the appearance of a table in the Table Properties box. Click in any cell in
the table, choose the Format menu then select Table Cell Properties. Click a tab—Table or
Cells—to reformat all or part of the table.
14. To check spelling, click the Edit menu and click Check Spelling to open the spelling dialog
box. Correct any spelling errors, if necessary. Click the Close button when you finish.

15. Click the Save
button. When the Page Title box appears, type a descriptive title, such as
“Publishing Documents on the World Wide Web” and click OK. You will then see the Save
Page As dialog box.
A. Click the down-arrow next to the Save in: box.
B. Click (C:), then double-click the folder in which you want to save your file.
C. In the File name box, type a name for the file:
webpage.html

then click Save.

Browse your Web page
Before you transfer your document to the Web server, you can look at (browse) it in a Web
browser. This is especially useful for checking special formatting, links, and images you have
included.
Exercise 4: Browse your file
1. Click the Browse button
on the Composition toolbar. If you have not saved the file
recently, KompoZer will prompt you to do so. You may see a window like the one below,
asking you to launch a browser in which to view the file:
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If you check the box before “Remember my choice for all links of this type,” you will see
this window only once. Click the Launch application button. The Web page will open in
your default browser.
2. When you finish browsing your Web page, click the X in the upper-right corner of the
browser window. Remember, you cannot edit your document in the browser window.

Name your home page
Most Web sites contain multiple files that are linked to a “home page” (your main or
introductory page). The most efficient way to handle a home page is to give it the name
index.html

The advantage to naming your home page index.html is that most browsers will display the
index.html file if no specific HTML filename is given. Thus, people searching for your personal
Web page on the “udel.edu” Web server only have to know your UDelNet ID to be able to find
your files, and people on the University’s central Web server would only have to know the name
of the directory in which your files reside. They do not have to remember an HTML filename to
get to your information.

Create links
The process for creating links is the same whether you are linking to a UD Web page or to Web pages
around the world. First you must know the URL (Uniform Resource Locator) or address for the page
you wish to link to. In the next exercise, you will create two links: one to the UD Home Page and one to
a resource outside the University.
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Exercise 5: Create links
1. Click an insertion point below the table. If Paragraph is not showing in the drop-down list
on the Format toolbar, click to select it.
2. Click the Link
button on the Composition toolbar. You will see a Link Properties box
like the one below:

3. In the Enter text to display for the link box, type
UD Home Page

4. In the Link Location box, type
http://www.udel.edu/

5. Under Target, click the box next to Link is to be opened and make sure in a new window is
selected in the drop-down box.
6. Click OK.
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7. Click the Format menu and click Discontinue Link. This step ensures that the following
text won’t be associated with the link.
8. Click an insertion point below the UD Home Page link and from the drop-down list on the
Format toolbar, choose Paragraph.

9. Click the Link button

on the Composition toolbar.

10. In the Enter text to display for the link box, type
Google

11. In the Link Location box, type
http://www.google.com

12. Under Target, click the box next to Link is to be opened and make sure in a new window is
selected in the drop-down box.
13. Click OK.
14. Browse your page and check that your link works correctly.

Include images
Before you include an image, make sure that you are not violating any copyright laws. You may
use the images available from the UD IdeaCenter at http://www.udel.edu/ideacenter/, although
there are some restrictions for student Web pages. Guidelines for students can be found in the
“Policy for Student Use of Computer Resources for Home Pages” at
http://www.udel.edu/webstart/stuorg/student.resource.html. Information on fair use guidelines
for educational multimedia can be found at http://www2.lib.udel.edu/subj/copyright/.
In the next exercise, you will add an image found at http://www.udel.edu/learn/cool.gif. Then
you will create a button and link it to return to the UD Home page.
Exercise 6: Add images
1. To insert an image, first click where you want the image to appear on the page. Then, click
the Image

icon. You will see the Image Properties box:
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2. In the Image Location box, type the URL of the image:
http://www.udel.edu/topics/learning/tutorial/cool.gif

3. Provide alternative text for those using non-graphical browsers. Click the radio button next to
Alternate Text and type the following in the box:
cool character

4. Note: If you are adding an image to your Web page from your hard drive, be sure to save
your Web page before adding the image. Then in the Image Properties box, click the Link
tab and check the box beside URL is relative to page location. This is necessary to make the
references to the images correct once you copy your Web page and its images to the Web
server.
5. Click OK.
6. You can also create linked images and buttons to enhance your page. Move your cursor in
front of the UD Home Page link. Click the Image icon on the toolbar then type the following
URL in the Image Location box:
http://www.udel.edu/images/Logos/hm.gif

7. Click the radio button next to Alternate Text and type the following in the box:
University of Delaware logo
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8. Click the Link tab. Type the URL for the UD home page:
http://www.udel.edu/
9. Click the Appearance tab. Set (or reset) the solid border to 0 pixels. Click OK.
10. Browse your page. (You will be asked to save the page first.)

Add features to your page
KompoZer provides buttons and menu options for adding many features to your Web page. For
instance, you can select a background color from the Page Colors and Background window. It
is important to think of the impact of the color or feature on the audience and to remember that
not all browsers display colors in exactly the same way.
You should include the date you last updated your file at the bottom of your page and be sure to
keep the information in your document current.
Exercise 7: Use the features available in KompoZer
1. Experiment with adding a background color to your page and changing the text color. To
alter the color scheme of your page, from the Format menu, choose Page Colors and
Background.
2. In the Page Colors and Background window, click the radio button next to Use Custom
Colors. Click one of the color buttons (Normal text, Link text, Active link text, Visited link
text or Background), then select a color.
3. Type the following URL in the Background Image box:
http://www.udel.edu/topics/learning/tutorial/background.jpg

4. Click OK.
When you use an image for your background, the image overrides any background color you
have set. If for some reason the background image cannot be displayed, the background color
will appear. Note: The user of the Web page can set color preferences (and other elements) to
override those you set in a Web page. Click an insertion point on the line below the last text
line of your page. From the Insert menu, select Horizontal Line to add a horizontal rule.
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5. Position the cursor on the line below the horizontal line and from the drop-down list on the
Format toolbar, choose Paragraph. Add the phrase
Last updated today’s date

6. Substitute the actual date for “today’s date.” Click the Save button.
7. Browse your page.

View the HTML source
All Web pages are constructed with HTML codes. When you create a Web page using
KompoZer, you don’t normally see these codes. KompoZer creates them for you. Sometimes, it
is useful to view the HTML codes. Since HTML codes are the “source” of the Web page, this is
often referred to as “viewing the source.” In the next exercise, you will view the source of your
Web page in KompoZer.
Exercise 8: View your HTML source
1. At the bottom of the KompoZer page, click the < > Source tab.
2. The < > Source (HTML file) appears in the window. Notice the information in the brackets
(< >). These are HTML tags. The Appendix describes the most common HTML tags and
their uses.
3. Click the Normal tab at the bottom of the page to return to the KompoZer editing window.

Publish your page
When you save your Web page in KompoZer, it writes the HTML source code to a file with the
extension .html. When you are satisfied with the appearance of your page, you are ready to
publish it. You now have to transfer a copy of the new files to your public_html directory on
Copland. When you save your file, KompoZer also saves the images (.gif or .jpg file) in the same
location. When you transfer your page, you also need to transfer any image files you have
added to your page. Remember that millions of people can view the page once it is on the Web.
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Use the Secure Shell File Transfer Program
The Secure Shell File Transfer window allows you to manage files on your computer and in your
UD server directory, including Web pages, images, documents, and more. With the file transfer
program, you will be able to:
View any directory or file on your computer and on the server.
Create, rename, move, and delete folders and files on your computer or within your server
directory.
Transfer any file or folder between your computer and your directory on the server.
Change the permissions of files in your server directory.
How to open the SSH File Transfer window
Exercise 9: Open the SSH File Transfer window
The SSH File Transfer window allows you to transfer files from your desktop computer to a
remote computer and from a remote computer to your desktop computer. You can transfer text
files, image files, and files created by applications such as Microsoft Word. If SSH is not still
open:
1. In the Applications folder, double-click the SSH Secure Shell Client icon.
2. Click Quick Connect.
3. In the Connect to Remote Host dialog box, type the following:
A. In the Host Name field, type copland.udel.edu.
B. In the User Name field, type your UDelNet ID.
C. Next to Authentication Method click the pull-down arrow and select Password.
D. Click Connect.
4. In the Enter Password dialog box, type your e-mail password and click OK.
5. On the SSH toolbar, click the File Transfer Window button:
You will see a window like the one below:
© University of Delaware Information Technologies
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Local Name
The Local Name pane on the left side of the window lists the files and folders on your computer
and enables navigation very similar to that in Windows Explorer. Files can be dragged from your
computer (Local Name) to the server (Remote Name) or from the server to your computer.
Remote Name
This area displays directories and files in your home directory on the UNIX server. You may
also view other server directories and files as needed.
File Transfer Status and History
The status of each uploaded or downloaded file will appear on the Transfer tab at the bottom of
the window. All actions are displayed in an exportable history list. The Queue tab displays files
ready for upload or download.
How to transfer files using the SSH File Transfer program
Exercise 10: Transfer files to your Web directory
1. In the Remote Name window pane, change to the public_html directory by double-clicking
the directory name (folder).

16

September 2010

Web Publishing with KompoZer

2. Select the format of the file you want to transfer:
Click
(ASCII) for files that contain only text or program source code. Examples
are files that end with .html, .htm, and .txt.

Click
(Binary) for files that contain formatting codes such as files produced by word
processing, spreadsheet, or image programs. Examples are Microsoft Word, Microsoft
Excel, .gif, and .jpg files.

Click

(Auto) if you are unsure of the format of the files.

3. In the Local Name window pane, locate the webpage.html file you created, and select it by
clicking its name.
4. Drag the highlighted file to the public_html directory in the right window pane.
Note: To transfer files from the server directory to your local computer, follow the directions
above, dragging the selected files to the left window pane.
How to set file and folder permissions (attributes)

If you are uploading a file that others will view on the Web, you must ensure that they will be
able to see the pages. Even though people may type the correct Web address to view your site,
they will not be able to see the material without permission. The attributes for a file or the folder
it is in must be set correctly on the server to give this permission.
Attributes are shown to the far right of the file or folder name. Use the scroll bar at the bottom of
the file window to reveal the attributes column. Again, Web page viewing is enabled by
changing the attributes of files and folders within your Web directory on the server:

© University of Delaware Information Technologies

17

Web Publishing with KompoZer

Users
Files and folders can have three types of users:
Owner The user with full rights to all files and directories within a specific server
directory space; this user can change file and folder attributes.
Group A select group of users listed by the owner.
Other All other users; users accessing your pages and directories through the Web or the
network.
Attributes
Files and folders can have the following attributes on the server:
D
The listing is a directory.
R
The file or folder can be read (viewed).
W
The file or folder can be written to.
X
The folder can be opened to access files (execute); a user can view Web pages in the
folder.
Recommended Attributes
The following settings are recommended to enable you to share your Web pages over the
Internet. Verify that that these settings have been applied to your Web folder and all files and
folders in it.
Folder (directory) Settings

Note: If you are part of a group where more than one person will change files in your folders,
click the Write check box for Group. The Permission mode will change to 775.

18
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File Settings

Note: If you are part of a group where more than one person will change the Web files, click the
Write check box for Group. The Permission mode will change to 664.
Exercise 11: Change Attributes in SSH FTP
1. Right-click the file or folder name in the remote pane.
2. Click Properties.
3. Click the check box for the desired attribute for the Owner, Group, and Other categories.
4. Click OK.
How to delete files or folders using the SSH File Transfer program
1. Select a file or folder you wish to delete from either the Local Name or Remote Name
window pane.
2. From the Operation menu, select Delete to delete the file or folder. Alternatively, you can
click the red X on the File bar.
3. A Confirm Delete dialog box appears, allowing you to confirm that you really want to delete
the selected files or folders. Click Yes to delete the selected items or Cancel to keep them.
4. Once you have transferred your KompoZer page to the Copland Web server, you will want to
browse it in a Web browser to see how it will look to the world.
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Exercise 12: Browse your published home page
1. Open your favorite Web browser.
2. In the Location box, type the URL of your new home page. Note: Do not include www or
public_html as part of the address.
http://udel.edu/~UDelNet_ID/filename

To change your Web page, edit the copy on your local computer and then repeat the
publishing steps using SSH File Transfer. If you change computers, you can open KompoZer
and choose Open Web Location from the File menu to download and edit the page.

Edit a page that is already on the Web
You can use KompoZer to edit a page that is already on the Web:
1.
2.
3.
4.

Download the page to your computer from within KompoZer.
Make editing changes.
Upload the page using SSH FTP.
Check the permissions for the page.

Follow these steps to edit an existing page:
1. While viewing the page you want to edit, from the KompoZer File menu, select Open Web
Location. You will see a dialog box like the one below:

A. Type the URL for the page you want to edit.
B. Click the Create button.
Note: This process will download a copy of the Web page and all the image files it contains.
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2. Modify the contents of the page using word processing techniques or the menu options and
format buttons. For example, if you want to delete text, highlight the text and press the
DELETE or BACKSPACE key. If you want to replace text, highlight the text and type the
new text. Or add a table using the Table button.
3. To insert an image, first click the mouse at the location where you want the image to appear.
Then either choose Image from the Insert pull-down menu or click the Image button.
Supply the name of the image file and provide alternative text for those using nongraphical
browsers. In your Web page:
A. Double-click each image.
B. In the Image Properties box, click the Location tab and check the box beside URL is
relative to page location. This is necessary to make the references to the images correct
once you copy your Web page back to the Web server.
4. To preview your page, click the Browse button on the Composition toolbar. Before you can
preview the document, you must save a copy on your local system. KompoZer will prompt
you to save the document.
5. Follow the directions in this document to transfer the page to your public_html directory.

© University of Delaware Information Technologies
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Appendix—View the elements of your Web page
Hypertext Markup Language (HTML) is the language used to create documents for the World
Wide Web. To view the source of a KompoZer document, choose the HTML Source menu item
from the View menu. Tags are used to label the elements of a Web page. Tags come in pairs, one
before and one after the text you want to act on.
<tag name>text</tag name>
For example, the code for creating boldface text is <b>; so, to make a word boldface, the code
would be <b>word</b>. Each Web page must have certain elements. The following list
describes some commonly used html tags.

22

<html> </html>

Placed at the very beginning and end of a document.

<head> </head>

Placed after the <html> tag. The “head” contains general
information about the document. Use the </head> tag at the
close of the “head” section.

<title> </title>

The title for your entire Web page. The title appears in the
blue area at the top of the browser and the code is placed
between the head tags.

<body> </body>

Placed after the </head> tag and before the final </html>
tag. The body contains the information that appears on your
Web page in a browser window.

<h#> </h#>

There are 6 levels of headings, <h1> to <h6>.
<h1> often uses the same text as the title. Headings
are placed around text for organizational purposes:

<h1>heading level 1</h1>
<h2>heading level 2</h2>
<h3>heading level 3</h3>
<h4>heading level 4</h4>
<h5>heading level 5</h5>
<h6>heading level 6</h6>

most important level

<pre> </pre>

Indicates that you want the text between these tags to
display as preformatted text—exactly as you designed it.

least important level
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<b> </b>
<i> </i>
<tt> </tt>
<blockquote> </blockquote>

Bold
Italic
Typewriter spacing (monospaced)
Sets off a long quotation

<ul>
<li></li>
<li></li>
</ul>

Unordered, bulleted list (without numbers)
List item

<ol>
<li></li>
<li></li>
</ol>

Ordered list (with numbers)
List item

<dl>
<dt></dt>
<dd></dd>
<dt></dt>
<dd></dd>
</dl>

Definition list (a term followed by a definition)
Definition term
Definition

<table></table>
<tr></tr>
<th></th>
<td></td>
<caption></caption>

Begin and end a table. You must add a “border”
attribute to have a border displayed (table border=1).
Define a table row.
Label the rows or columns or both.
Include data in the table.
Give the table a caption.

<p></p>

Insert a paragraph break.

<hr />

Insert a horizontal rule.

<br />

Insert a line break.

<a href=“filename”>text</a>

A hypertext reference for creating a link.

<img src=“image name”>

The code for including images in a Web page.
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